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Abstract 

Stress affects the resonance properties of materials. A suitable technology and 

instrumentation for calculating stress in pre-installed oil pipeline bolts is developed 

and tested. The technology, Resonant Ultrasound Spectroscopy (RUS), relates the 

change in bolt resonances to bolt stress, using analysis software. A suitable 

instrumentation that excites the bolt over a band of frequencies through a broad band 

sweep and measures the response to compute resonances and bolt stress is developed. 

The instrumentation and the analysis software operate in a loop with minimum 

operator input to predict stress in the bolts. The project is primarily aimed at the oil 

and gas industry but has the potential to fit bolt-testing applications in aerospace, 

defence and manufacturing industries. 

The proposed testing method is new to Non Destructive Testing (NDT) of oil 

pipeline bolts and has no peers. A calibration data set is built using the resonance 

information extracted from a set of bolts. Test results are discussed and areas of future 

work explored. A stress prediction accuracy of ± 20% has been achieved with a group 

of 10 B7 bolts. This project is a Knowledge Transfer Partnership (KTP) project and 

was done at Hedley Purvis Ltd., in association with Durham University. 
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CHAPTERl 

INTRODUCTION 

The aim of the project is to develop a suitable instrument to measure stress in 

pre-installed bolts and evaluate measurement software. The project is based on 

Resonant Ultrasound Spectroscopy (RUS). Resonances of a bolt change if its material 

property changes. A change in bolt stress induces a relative shift in resonances with 

reference to resonances measured when the bolt under test is unstressed. Further, the 

temperature of the bolt affects speed of sound and hence its resonances. The extension 

length of the bolt on the either side of the flange also affects resonances. Variations in 

resonances induced by temperature and position are taken into account and 

compensated by suitable means. 

Using resonances to calculate stress in bolts is a new concept to the joint 

integrity marketplace. Resonances have been widely used in materials testing and 

intelligent defect detection. In a manufacturing environment, resonances of a 

manufactured component are checked to verify if it correlates with the resonances of 

similar good components [10]. The result of that test either passes or fails the 

component based on its resonance match. Resonant inspection has also been used to 

compute elastic properties of a material using Resonant Ultrasound Spectroscopy 

(RUS) [10]. 

The technologies such as ultrasound pulse-echo and eddy current are available 

for stress prediction but they require previous information of the bolt under test. In 

order to predict stress in a pre-installed bolt, pulse-echo and eddy current require the 

bolt to be tested in unstressed condition i.e. before the bolt is installed in a flange. The 

resonant inspection instrument could be used to test bolts in flanges without having 

information of the flange bolt previously. Instead a calibration database which 

contains resonance information of the bolts that are similar in length, material 

composition can be used to predict stress in flange bolts. Oil and gas pipelines are 

often expensive and hazardous to break up, hence RUS would find its use in situations 

where bolt stress is to be measured in flanges, without prior knowledge of the bolt. A 
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calibration data set forms the core of proposed test instrument. The data set is built by 

performing tests with a group of 10 bolts. Each bolt type has its own data set. The bolt 

type used for this project is a 1" 1/8 B7 bolt, made of steel. This bolt is used to 

makeup joints in the oil and gas pipelines. For each of the 10 B7 bolts, the 

information in the data set is organised to contain the length of the bolt (mm), 

extension of the bolt on either side of the flange (mm), temperature at the time of 

measurement (degree C), bolt load (KN) and 3 resonances (Hz). 

When a bolt is tested, the instrument picks 3 resonances resulting from the 

broadband sweep. These resonances are then processed using the analysis software 

that performs a multiple regression analysis on the calibration data set to predict 

stress. 

The project consists of two main parts 

1. Hardware and software development 

2. Building a calibration data set to predict stress 
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CHAPTER2 

LITERATURE SURVEY 

A literature survey was done on Resonant Ultrasound Spectroscopy and the currently 

available techniques and instruments to measure stress in bolts. 

2.1 Resonant Ultrasound Spectroscopy 

RUS originated in National Los Alamos Laboratory, USA. It has been used for 

industrial applications during the last four years of commercialisation by Quasar 

Inc. It is a whole-body resonance inspection method that is particularly suited to 

inspecting smaller mass produced hard components, and one test will inspect the 

complete component without need for scanning, immersion in liquids, chemicals, 

abrasives or other consumables [11]. 

Operational Theory of RUS 

Hard components have their own resonant frequencies. A bell will ring with 

specific note. This note is actually a combination of several pure tones, each 

representing a different resonance mode of the bell or harmonics of them. Wine 

glasses also have resonant frequencies. The tone of the ringing depends upon the 

size of the glass, a small glass ringing at a higher note than a large glass. This 

implies that resonant inspection can differentiate between components of different 

sizes. A bell and glass of the same size will ring at different frequencies. This 

implies that resonant frequency is dependant upon the material of tested 

component. In addition, a good bell or wine glass will ring true, whilst a cracked 

bell or wine glass will ring with a "cracked note" or will "clunk" instead of 

ringing. This tells us that we can detect cracks in resonant inspection. People have 

been inspecting components by hitting them with a hammer and listening to them 

ringing for centuries. Modem electronics have enabled us to take the human 

element out of the inspection process, thus measuring more frequencies and 
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recognising more subtle changes than are detectable with human ear. This also 

enables automation of the inspection process and also move into the ultrasound 

region to detect smaller differences. 

Resonant inspection operates by exciting a component with a sine wave 

excitation at one specific frequency (thereby putting all of the energy into that 

one frequency) then quickly sweeping all the individual frequencies through the 

required range [1]. A hammer striking the component will put all the energy into 

a broad spectrum (from DC up to hundreds of kilohertz), with only a small 

amount at the resonant frequencies. This swept-sine wave approach allows a 

much improved signal to noise ratio compared to the hammer blow technique [1]. 

A narrow band filtered typically only several Hertz wide, will recover the swept 

sine wave. This vastly improves signal to noise ratio and raises the detectability 

of inspection by orders of magnitude compared to the old hammer method [1]. 

The invention of RUS relates to acoustical measurements in solid materials 

and more particularly to the use of resonant ultrasound spectroscopy to determine 

a variety of material properties. The elastic properties of solid crystals, metals, 

alloys, ceramics and glasses are some of the most basic data in the physical 

sciences. Acoustic resonances data are also related to defects and sound 

dissipation properties of the material [2]. While stressing a bolt, it dissipates 

sound due to the stretch in bolt. Hence resonance affects stress in bolt. 

2.2 Ultrasonic Pulse-Echo measurement: 

Ultrasound pulse-echo is widely used to measure stress in bolts. This 

method is based on calculating the time of flight of an ultrasonic pulse between 

the two ends of the bolt. A stressed bolt is longer than the unstressed bolt. Time 

of flight measurements on the bolt before and after it is stressed gives a time 

difference that can be used to calculate stress in the bolt as a function of 

elongation due to stress. 

When threaded fastening systems (comprised of a bolt or stud and a 

nut) are tightened, the threaded fastener is said to be tensioned. The tensioning 

force in the fastener is equal to the fastening system's clamping force. Tensioning 

force is also called load. An ultrasonic pulse-echo instrument determines the load 
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in the fastener by measuring the amount of time it takes for a sound wave to 

travel along a fastener's length, before and after the tensioning force is applied to 

the fastener [3]. The fastener material's acoustic velocity, together with difference 

in measuring times, allows the instrument to calculate the change in fastener 

length under the tensile load [3]. Provided the fastener's dimensional and material 

properties are known and the constants that represent the material properties are 

entered into the instrument, the pulse-echo instrument calculated the load and 

stress present when the fastener is in its tensioned state [3]. 

For at least 15 years attempts have been made to use ultrasonics to 

measure bolt preload, the tension in a tightened bolt or stud. For example, 

conventional time-of-flight thickness gauges were used in an attempt to detect the 

small change in length that occurs when a fastener is tightened. The time required 

for the ultrasonic signal to make a round trip in the fastener is, however, affected 

by the change in stress level in the fastener (ultrasonic velocity decreases as stress 

increases) and by the increase in path length. A conventional thickness gage 

doesn't expect to encounter a stress change, so it gives a "wrong" answer that 

must be analyzed to determine the actual change in the "thickness" (length) of the 

bolt. It is not a simple matter to predict the ratio between the stress effect on 

transit time and the strain effect, even today. As a result, the data obtained with 

conventional ultrasonics required too much analysis and interpretation to be of 

use. 

Another problem with conventional ultrasonics was the high resolution 

required to measure the tiny changes that occur in a bolt as it is loaded. For short 

fasteners with typical length 50 mm, an instrument capable of measuring a 

change in length of about 0.0000127 % (0.002 mm or even 0.0002 mm) is 

required. Thickness gages in general did not have the required accuracy. 

However, the need for accurate preload control, to check such things as fatigue, 

vibration loosening, and leaks, remained so that interest in ultrasonic 

measurement persisted in spite of the difficulties. Since 1976, a number of 

instruments (some of them digital) have been placed on the market. 

Although ultrasonic measurement of preload is still not widespread, the 

practical problems are slowly being overcome, and usage is increasing. Recent 
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work, for example, has involved such things as bridges, critical joints in 

natural gas compressors, off-road construction equipment, foundation bolts in 

nuclear construction, and critical joints in refineries and petrochemical plants 

where the goal is leak prevention. Some case histories are presented below. 

Principle of operation: 

The principle of operation of a typical digital extensometer is fairly 

straightforward. A pulser within the instrument shocks a transducer which then 

delivers a brief, highly damped pulse of ultrasound (typically about 1 or 1/2 

cycle) to one end of the fastener. This pulse travels through the fastener, 

echoes off the far end, and returns to the transducer. The instrument measures 

the transit time, or time of flight, required for the pulse to make the round trip. 

The time is entered in the memory bank of the microprocessor inside the 

extensometer. The bolt is then tightened, increasing the length of the path the 

signal must travel and decreasing the velocity of the ultrasound. The new, 

increased transit time is also entered in the microprocessor's memory. 

The microprocessor computes the total change in transit time, 

computes and discards the portion of the change that resulted from the change 

in velocity, and presents a readout of the actual change in the length of the 

fastener. Note that in order for the microprocessor to give a readout of the 

actual change in length, it must make and statistically average a large number 

of measurements of transit time. This is because the change between 

unstressed and stressed transit times is very small - a fraction of a nanosecond. 

To interpret such a difference accurately enough with only one measurement 

would require logic and timing circuits operating at megahertz or gigahertz 

speed. This would mean state-of-the-art logic, presently available only under 

laboratory conditions, and that would mean a lot of field problems and a very 

high unit cost. Since measurement errors will be randomly scattered, however, 

a suitable degree of accuracy can be obtained by taking many measurements 

and computing their statistical mean. 

One other factor must be considered. A temperature change will affect 

the length of the fastener and the velocity of the ultrasonic signal. If the 

temperature of the fastener changes between stressed and unstressed readings, 
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the influence of temperature on velocity and length must therefore be factored 

out by the microprocessor. 

Advantages of Ultrasonic Control 

1. Controlling bolt preload by ultrasonically measuring elongation is far more 

accurate than torque and/or turn control. 

2. In an actual field situation, all the bolts in a joint can be measured and 

controlled in this way, not just a few strain-gauged samples. 

3. Ultrasonic measurements of stretch are more accurate than measurements 

made with a micrometer. If the operator is skilled, ultrasonic measurements 

are faster than measurements made with a micrometer. Note, too, that access 

to only one end of a fastener is needed to measure it ultrasonically. 

4. Both dynamic and static measurements can be made, and residual preload can 

be measured at any time after the initial tightening. This means that one can 

monitor short and long-term relaxation effects, external load effects, 

temperature effects, vibration loosening, fatigue loading, and the like. Again, 

these things can be done on all of the bolts in a joint, not just a few strain-

gaged samples. 

5. The extensometer can be used to control any kind of tool, from a torque 

wrench to a tensioner to a slug or impact wrench. For example, the fastest way 

to do a job is often with an impact wrench. Using the extensometer for control 

makes this a very accurate procedure. 

6. Using an extensometer for control can often speed up a job. For example, a 

joint can often be put together with fewer passes, because one can see and 

compensate for relaxation effects, bring up all the fasteners together, avoid 

over tightening, and so forth. 

Disadvantages of Ultrasonic Measurement 

Given the present state-of-the-art, there are also some disadvantages to 

ultrasonic measurement: 
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1. In order to obtain the most accurate readings, the instrument must be 

recalibrated for each new application. The calibration procedure is simpler 

than it was a few years ago, but it is still necessary. 

2. It takes a fair amount of operator skill to use the instrument. Such factors as 

selection and placement of the transducer, what to do if signal strength is 

seriously reduced by bending in the fastener and a phenomenon called "peak 

jumping" all require a trained operator. 

3. The results obtained with the extensometer are often a surprise. Jobs can be 

slowed or stopped as engineers struggle to analyze, explain, and compensate 

for some of the things revealed by the extensometer. It must be recognized that 

the phenomena revealed by the extensometer have always been present; it is 

just that they have never been observed before. Once the phenomena are 

observed, one must explain and/or do something about them. 

4. It is necessary to keep a log of the original length of each fastener if one wants 

to tighten a joint in multiple passes or make long-term measurements. 

Measurement Accuracy 

The current ultrasonic time-of-flight instruments are capable of 

resolving a change in length as small as 0.0002 mm for fastener lengths up to 

6350 mm. However accuracies like these are possible only in aerospace, 

laboratory, or quality-control conditions. In most work at construction sites or 

petrochemical plants, the measurements are usually accurate to the nearest 

0.013 mm, and the measurements are used to control preload within 5 to 15 

percent. The length of a typical B7 bolt used in oil and gas pipeline is 160 mm. 

The working load of the bolt is about 140 kN- 220 kN. A 140 kN load causes 

a 0.2625 mm extension in bolt length. It corresponds to a strain of 0.0016. At 

160 kN, the extension in bolt length is 0.2905 mm. The change in bolt length 

between 140 kN and 160 kN is 0.028 mm, which is within the resolution of the 

instrument i.e. 0.013 mm. However the difference 0.028 - 0.013 mm = 0.015 

mm can be easily masked by factors such as protrusions, rust or cracks on the 

bolt surface. The ultrasonic transducers use gels as coupling agents, which 

adds to the overall change in length. Bolts in oil and gas pipelines are rarely in 

polished condition and the amount of gel used as couplant may change every 

time a measurement is made. Hence these practical limitations constitute to the 
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measurement error. If for example the practical constraints add a 0.015 mm to 

the overall length, the stress measurement accuracy is 9.1 %, which 

corresponds to +20 kN on a scale of 0-220 kN. 
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CHAPTER3 
BACKGROUND THEORY 

This section discusses the background theory of Resonant Acoustic Inspection 

and brings forth the ideas to achieve project objectives using appropriate 

instrumentation and test procedure. An Instrument setup and test strategies are derived 

from this section. 

3.1 Acoustic waves 

A wave is defined as a disturbance or variation that transfers energy 

progressively from point to point in a medium and that may take the form of an elastic 

deformation or a variation of pressure, electric or magnetic intensity, electric potential 

or temperature [4]. Importantly, a wave is a disturbance or variation which travels 

through a medium. The medium (bolt) through which an acoustic wave travels may 

experience some local oscillations as the wave passes, but the particles in the medium 

do not travel with the wave. The disturbance may take any of a number of shapes, 

from a finite pulse width to an infinitely long sine wave. In RUS, the bolt is excited by 

the acoustic sine wave. This is derived from the previous work on Resonant 

Ultrasound Spectroscopy, at National Alamos Laboratory, U.S.A. When longitudinal 

waves pass through air, the particles in air oscillate back and forth about their 

equilibrium positions but it is the disturbance which travels, not the individual 

particles in the medium. In the same way, transverse waves on a bolt are another 

example. The bolt is displaced up and down as the wave travels from left to right, but 

the bolt itself does not experience any net motion. This explains that the output of the 

receiving transducer is a sine wave. 

There are two basic types of wave motion. Longitudinal and Transverse 

waves, see fig 3.1. In longitudinal waves, the particle displacement is parallel to the 

direction of wave propagation. The particles do not move with the wave; they simply 
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oscillate back and forth about their equilibrium positions. The wave is a motion of the 

compressions and rarefactions, i.e. it is a pressure wave. In transverse wave the 

particle displacement is perpendicular to the direction of wave propagation. The 

particles do not move along with the wave, they simply oscillate up and down about 

their equilibrium positions as the wave passes. 

11111,1111111,111111 ' Direction of wave propagation 
Direction of LongitudinalWave

Particle Motion t 

Particlesatrestposition

Directionof t Shear waveParticle Motion
l 

Fig 3.1 Longitudinal and Transverse waves 

Another example ofwaves with both longitudinal and transverse motion can be found 

in solids as Rayleigh surface waves . The particles in a solid, through which a 

Rayleigh ssurface wave passes, move in elliptical paths, with the major axis of the 

ellipse perpendicular to the surface of the solid. As the depth into the solid increases 

the "width" of the elliptical path decreases. In a Rayleigh surface wave, particles at 

the surface trace out a counter-clockwise ellipse, while the particles at a depth of more 

than 1/Sth of a wavelength trace out clockwise ellipses. The table 3.1 (a) compares 

various wave types in solids and their corresponding particle vibrations [4]. 
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!Wave Types in Solids Particle Vibrations 

!Longitudinal Parallel to wave direction 

Transverse(Shear) Perpendicular to wave direction 

!surface - Rayleigh Elliptical orbit- symmetrical mode 
<~ 

Table 3.1(a). Wave types in solids and their mode of vibration. 

Among the properties of waves propagating m isotropic solid materials are 

wavelength, frequency, and velocity. The wavelength is directly proportional to the 

velocity of the wave and inversely proportional to the frequency of the wave. This 

relationship is shown by the following equation. 

l velocity(v) wave engt = ___ 
frequency(/) 

The quoted parameters of structural steel are as follows [5]. 

Young's Modulus: 200 GPa 

Poisson's ratio: 0.26 

Density: 7850 kg/m3 

Longitudinal wave speed: 5583.3 m/s 

Transverse wave speed: 3179.7 m/s 

Rayleigh wave speed: 2928.6 m/s 

The particle motion in Rayleigh wave speed goes from counter-clockwise to 

clockwise at a depth of 0.1902 times the wavelength. 

3.2 The Simple Harmonic Oscillator 

In order for mechanical oscillation to occur, a system must posses two 

quantities: elasticity and inertia. When the system is displaced from its equilibrium 

function, the elasticity provides a restoring force such that the system tries to return to 

equilibrium. The inertia property causes the system to overshoot equilibrium. This 

constant play between the elastic and inertia properties is what allows oscillatory 
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motion to occur. The natural frequency of oscillation is related to the elastic and 

inertia properties by [ 6] 

elasticity wo= 2mfo = 
inertia 

Where, f0 =natural frequency or resonant frequency. 

(3.1) 

The simplest example of an oscillating system is a mass connected to a rigid 

foundation by the way of spring. The spring constant k provides the elastic restoring 

force, and the inertia of the mass m provides the overshoot. By applying Newton's 

second law F = ma to the mass, one can obtain the equation of motion for the system 

[6]. 

(3.2) 

Where, w0 is the natural oscillating frequency. The solutions to this equation 

of motion take the form [6] 

x(t) = xm cos(w0t + 0) (3.3) 

where xm is the amplitude of oscillation and 0 is the phase constant. Both xm and 0

are constants determined by the initial condition (initial displacement and velocity) at 

time t=0 when one begins observing the oscillatory motion. The period of oscillatory 

motion is defined as the time required for the system to start one position, complete a 

cycle of motion and return to the starting position. 

When damped and un-damped mass-spring systems are released from rest, the 

un-damped mass exhibits simple harmonic motion while the damped mass exhibits an 

oscillatory motion which decays with time. When the bolt is excited with a sine wave, 

it can be studied as a forced harmonic oscillator. 

3.3 Vibration of a fixed-fixed string 

The vibration of a string whose ends are fixed can be used to understand 

natural resonances in a bolt. When the end of the string is fixed, the displacement of 
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the string at that end must be zero. A transverse wave travelling along the string 

towards a fixed end will be reflected in the opposite direction. When a string is fixed 

at both ends, two waves travelling in opposite directions simply bounce back and 

force between the ends [ 6]. 

y(x,t) = Ym sin(kx-wt)+ Ym sin(kx+wt) (3.4) 

The equation for wave travelling in the opposite direction is given by 

y(x,t) = Ym sin(wt- kx) + Ym sin(wt + kx) (3.4 a) 

The vibration behaviour of the string depends on the frequency (and wavelength) of 

the waves reflecting back and forth from the ends. A string which is fixed at both ends 

will exhibit strong vibration responses only at the resonant frequencies. 

(3.5) 

where v = is the speed of transverse mechanical waves on the string, Lis the 

string length and n is an integer. At any other frequencies, the string will not vibrate 

with any significant amplitude. The resonance frequencies of the fixed-fixed string are 

harmonics of the fundamental frequencies (n =1). 

The vibrational pattern (mode shape) of the string at resonance will have the form [6] 

y(x,t) = Ym x)cos(2mft) 
L 

(3.6) 

This equation represents a standing wave. There will be locations on the string which 

undergo maximum displacement (antinodes) and locations which do not move at all 

(nodes). In fact, the string may be touched at a node without altering the string 

vibration. 

When a swept sine wave is introduced into an ultrasonic transducer, the 

transducer produces a swept sine wave of mechanical vibration. The vibration could 

be dry coupled into the bolt and the bolt itself begins to vibrate at the same frequency 
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as the sine wave. When the frequency of the sine wave generated equals one of the 

bolt's resonant frequencies or Eigen frequencies, the amplitude of vibration in the bolt 

increases greatly, the bolt acting as a mechanical amplifier. A receiving transducer 

could be placed opposite to the transmitting end, to measure the amplitude of the 

vibrations in the component at the moment in time and at the same frequency as the 

generated vibration. The received signal can be amplified and filtered using a band-

pass filter to improve the signal to noise ratio of the signal. An amplitude vs 

frequency plot can then be drawn for each vibrational amplitude and signal frequency 

in order to obtain a spectrum of the bolt. 

3.4 Resonance 

Resonance is a result of constructive and destructive interference of standing 

waves in an ultrasonic medium. Frequency is inversely related to wavelength by the 

equation [7] 

V=FA. (3.7) 

Where, 

V is the sound velocity in the ultrasonic medium 

F is the ultrasonic signal frequency 

,wavelength. 

The fundamental frequency occurs when there is half of a wavelength in the 

bolt, so twice the length of the bolt can be substituted for In the equation (3.7). 

V=Fx2L (3.8) 

Where, 

L is the length of the bolt. 

The harmonic frequencies are integer multiples of the fundamental frequency 

and they occur when there are multiples of in the bolt length (i.e. length of the 

bolt, L = etc.) 

At the harmonic frequencies, the incident and reflected waves are in phase and 

therefore cause constructive interference. Conversely, when the thickness of a 

medium equals odd multiples of (i.e. etc .. ), the incident and 
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reflecting waves are out of phase causing destructive interference. The periodic 

constructive and destructive interferences in a resonance spectrum can be termed 

resonant peaks and valleys. Because the harmonic frequencies are integer multiples of 

the fundamental frequencies, the spacing of the resonant peaks equal to the 

fundamental frequency. The resonant frequency spacings in a spectrum can give a 

thickness measurement if the velocity is known and vice versa. 

The fundamental resonant frequency is calculated using the expression 

F=V/2L (3.9) 

3.5 Bolt Theory 
Most fastener applications are designed to support or transmit some form of 

externally applied load. The most widely associated mechanical property associated 

with standard threaded fasteners is tensile strength. Tensile strength is the maximum, 

tension-applied load the fastener can support prior to or coinciding with its fracture. 

The maximum tensile load a fastener can withstand is determined by the formula [8] 

P = Stx As 

where 

P =tensile load (lb., N) 

St = tensile strength (psi, MPa) 

As= tensile stress area (sq. in, sq. mm) 

The proof load represents the usable strength range for certain standard 

fasteners. By definition, the proof load is an applied tensile load that the fastener must 

support without permanent deformation. In other words, the bolt returns to its original 

shape once the load is removed. 

Steel possesses a certain amount of elasticity as it is stretched. If the load is 

removed and the fastener is still within the elastic range, the fastener will always 

return to its original shape. If, however, the load applied causes the fastener to be 

brought past its yield point, it now enters the plastic range. Here, the steel is no longer 

able to return to its original shape if the load is removed. The yield strength is the 

point at which permanent elongation occurs. If we would continue to apply a load, we 

would reach a point of maximum stress known as the ultimate tensile strength. Past 
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this point, the fastener begins to "neck" and elongate further with a reduction in stress. 

Additional stretching will ultimately cause the fastener to break at the tensile point. 

Figure 3.5 illustrates a typical stress-strain relationship of a bolt as a tension load is 

applied. 

T 
e 
Il 

s 
1 

o

n 

Yield. 
Point 

Changein Length

Figure 3.5. Tensile Stress-Strain Diagram for a steel bolt 

3.6 Tension Control in Bolted Joints 

Failure
(Tensile, Point) 

Threaded fasteners can do a good job of holding things together only when 

they are properly tightened. The fastener to ensure the proper performance of the joint 

must produce an appropriate tension. To this day a simple, inexpensive, and effective 

way to determine if a fastener is properly tightened has not been found. Through the 

years, satisfactory ways have been discovered, but they are neither simple nor 

inexpensive. In most situations we rely on less-than-perfect, but adequate traditional 

methods. 

Were most joints not massively over-designed to accommodate inaccurate 

tightening, simple tightening procedures could prove in-adequate. Designers will 

specify more or larger bolts than needed in order to ensure that the joints are clamped 

together with the amount of force required. Fewer or smaller fasteners can be used 

when accurate control of bolt tension or preload is assured during assembly. For most 

applications the over-design of the joint has been far cheaper than controlling the 

assembly process. 
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Current trends for most applications, however, no longer favor the use of over-

design. Increasing demands on cost, strength-to-weight ratios, product performance, 

and environmental concerns have put pressure on designers, manufacturers and 

assemblers to do a better job with. fewer, lighter parts. This trend has lead to the 

discovery of more options in controlling design preload. 

Whenever we tighten a bolt, a sequence of events takes place. By applying 

torque to the head, or the nut, we turn the fastener being torqued. This action stretches 

the bolt (similar to a spring) and creates a tension in the bolt. In most cases it is this 

tension or preload that we need to make a fastening. By controlling torque, turn, or 

stretch, we can control the buildup of tension. The closer we approach direct control 

of tension, the more accurate and expensive the method will be. 
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CHAPTER4 

INSTRUMENT DEVELOPMENT 

Instrument development is done in two stages 

1. Specification 

2. Writing system software and integration 

The ultimate goal of the instrument is to excite the bolt at its resonant frequencies and 

extract useful resonances from the bolt, so that analysis software in a laptop computer 

can process the information to predict stress. A suitable set of instruments are 

specified and procured to be customised and integrated as in fig 4.1, 4.2 and 4.3. 

4.1 Hardware Specification: 

For the bolt to be excited at its resonant frequencies with a clean sine wave, a 

very high resolution sweep generator is required. A resonant inspection transducer 

converts the signal from the sweep generator into an equivalent acoustic wave. The 

transducer is in direct contact with the bolt surface and the acoustic wave is 

transmitted into the bolt. Another transducer at the receiving end of the bolt senses 

any pressure wave or vibration that is set up in the bolt and converts it into an 

equivalent electric field. At a bolt resonance, the output of the receiving transducer is 

typically 2- 10 mV for a 1' 1/8", 160mm long B7 bolt. The maximum data logger 

sensitivity is 200 mV. Hence a voltage pre-amplifier is needed to boost the signal to 

acceptable levels. The output of the amplifier is connected to the data logger which 

converts the signal into digital values and stores in a data file for further processing. A 

detailed description of each instrument follows. 
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Fig 4.2 Structure of load cell 

160 mm 

28.58 mm 

Fig 4.3 Bolt dimensions - Length and diameter 
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4.1.1 Resonant Inspection Transducers 

Transducer is a term used to define a component which converts one form of 

energy into another. It is a device in which the application of an electric field 

across the active element produces mechanical deformation of the active element 

thereby generating ultrasonic vibrations and vice versa [12]. The transducer forms 

the actual core in all non-destructive ultrasonic inspection procedures. The choice 

of correct transducer is decisive for the quality and reliability of inspection results. 

Depending on the application, transducers differ with respect to the size of active 

piezoelectric elements, their frequency, bandwidth and basic design. The sound 

field characteristics of a transducer, which are expected under normal inspection 

conditions, are generally derived from the diameter and frequency of the 

piezoelectric element. 

For the bolt to be excited at a sufficiently large number of resonances, the 

frequency of operation range is between 1 kHz - 200 kHz. The transducer is 

designed to have its own resonant frequency outside its operating range. Quasar 

Inc. based in U.S, is the leader in supplying components for resonant inspection. 

Quasar resonant inspection transducers are highly suited to measuring bolt stress 

due to its operating bandwidth of 10kHz-200kHz. The bolt resonances are in 

the region of 20 kHz - 200 kHz. The transducer is ceramic tipped so as to 

minimize the transducer becoming a part of vibrating system i.e. bolt. Ceramic 

tipping also allows contact on hot surfaces. Diameter and crystal characteristics of 

the transducer element are with held by the supplier. 

4.1.2 DS335- Very High Resolution Sweep Generator. 

Based on Direct Digital Synthesis (DDS) architecture, the DS335 sweep 

generator shown in fig. 4.4 is capable of generating frequencies from 0.01 Hz -

3.1 MHz. It can generate sinusoidal, square, triangle waves. The frequency 

resolution of the device is 1 uHz. The resolution of frequency step that is required 

for a sweep to accurately identify resonances is 1 Hz. Frequency steps below and 

above 1 Hz were tried and concluded that 1 Hz is the optimum step to identify 

resonances accurately. The DS335 supplied by Stanford Research systems has a 

BNC (F) output, capable of outputting a 20 Vp-p sine wave into a high impedance 

load. Into low impedance load (50 Ohm) it can output 10 Vp-p. The load of the 
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sine wave generator is the input transducer. The transducer's input impedance was 

determined to be 1200 Ohm, using impedance analyser. 

Figure 4.4 DS335 Function Generator 

All instrument functions can be set and read via the GPIB (General Purpose 

Interface Bus) interface on the rear. A GPIB- USB adaptor supplied by National 

Instruments is used to control the parameters of DS335 with a software program 

written in C/C++. 

4.1.3 HS3 - Analog Data Acquisition Device 

The Handyscope HS3 shown in fig. 4.5 is a powerful computer controlled 

measuring instrument that consists of four measuring instruments: a Multimeter, 

an Oscilloscope, a Spectrum analyzer and a Transient recorder. An AWG 

(Arbitrary Waveform Generator) is ,also available. The Handyscope HS3 features 

a user selectable 12 bit, 14 bit or 16 bit resolution (14 bit effective, SNR 95 dB), 

200 m V - 80 V full scale input range, 128 K samples record length per channel 

and a sampling frequency up to 25 MHz on both channels. 

Connected to the fast USB 2.0, the Handyscope HS3 doesn't require an 

external power supply, therefore the Handyscope HS3 easily complies to "Plug in 

and measure". HS3 finds its application in this project as a spectrum analyser and 

an analog data acquisition device. 

For analysing the spectrum of a bolt, the signal generator output of the HS3 is 

connected to the input transducer that is connected to the bolt. The output of the 

26 



receiving transducer is connected to the Channel 1 input of HS3. The sweep 

generator present in the HS3 signal generator is set to sweep over a bandwidth to 

excite the bolt. The response of the bolt is measured through the HS3 spectrum 

analyser. 

Figure 4.5 HSJ Measuring System 

A. FFT 

The spectrum analyser software uses a FFT algorithm to calculate the 

magnitude of the signal at each frequency outputted by the sweep generator and 

plots it. The number of samples over which the FFT is done can be set from 

128 samples (2A7 = 128 samples, because the FFT is done on samples over 

multiples of 2) to 32768 samples (2A15 samples). The spectrum analyser also 

allows for 'windowing' the signal so that spectral leakage does not occur while the 

FFT is done. A Blackman -Harris window is used for RUS because the window 

cuts off the edges of acquired signal to avoid signal discontinuities. While there is 

no particular windowing technique suited for all applications, Blackman - Harris 

windowing method is chosen since it gives best results for the particular signal on 

hand. Other windowing techniques were used to identify the most suitable 

method. 

B. Sensitivity 

The sensitivity of the ADC in the Handyscope ranges from 200 m V - 80 V. 

The sensitivity settings are important in two contexts. One is while considering 

the voltage of input signal coupled to the ADC from the output resonant 

inspection transducer. The sensitivity settings of the ADC should match the signal 

amplitude at its input. Two is when the HS3 is being operated as a data acquisition 

device for a sweep by DS335 signal generator, the sensitivity settings are matched 
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correctly to signal amplitude so as to reduce quantisation noise in the ADC. For 

example, for a resonance whose sine wave amplitude varies between -3V to +3V, 

the correct sensitivity setting is 4 V. Using 8V increases the quantisation levels 

and thereby increasing the probability of quantisation error, which degrades signal 

quality. 

C. HS3 Signal Generator 

When HS3 is used as a spectrum analyser, there is an in-built signal generator 

in HS3 capable of operating as a sweep generator in sync with the spectrum 

analyser. The sweep generator outputs a signal and does not output the next 

frequency signal until the spectrum analyser has computed an output by doing a 

FFT. It is capable of outputting 10 Vp-p into a high impedance load. 

D. Miscellaneous Settings 

The interpolation button can be used to smooth the spectrum in the spectrum 

analyser. A software gain can be applied on the spectrum to improve visibility. 

Cursors can be used to find values in the spectrum. The digital values of the 

spectrum can be stored in a data file for further processing. 

4.1.4 Low noise voltage pre-amplifier (Model 5113) 

The pre-amplifier supplied by Signal Recovery Inc., is a high performance, 

low noise voltage preamplifier [fig 4.6] with continuously adjustable gain and 

high, low or bandpass filtering. Its input can be configured for either single-ended 

or true differential operation with either DC or AC coupling, and its output will 

deliver up to 2Vp-p into a 50 Ohm load. All the principal instrument controls are 

operated via the three front-panel rotary knobs and a back-lit LCD display shows 

their present settings. The unit also includes a 'sleep' function whereby every 

source of digital noise is turned off after a predetermined interval by switching off 

the internal microprocessor. The unit can either be continuously line-powered 

from the supplied model PS0108 power supply, or be run from the internal 

rechargeable batteries. 

If the signal of interest is limited to a single frequency or narrow range of 

frequencies, then the signal channel filters allow selective amplification of the 

signal. The filters can be switched out of use to give a flat frequency response. 

Typical settings of the voltage pre-amp are Gain: 500, A-B l's for AC coupling, 
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30 kHz - 300 kHz bandpass filtering. Please see Annexe B for pre-amp 

specifications. 

Fig 4.6 Model 5113 Low noise pre-amplifier 

4.1.5 Load transducer & Thermocouple 

A load transducer [fig 4.7], is used to calculate the load in a bolt, while testing 

in a test rig. The load transducer displays the load on the ,test bolt in KN, to be 

used in calibration data set. It sits in between two spacers that act as a flange in the 

test rig. The transducer is connected to a measurement box which gives the load 

read out. 

KN 

D 

Display electronics 

Load transducer 

Fig 4.7 Load transducer (top view) and display system 
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A thermocouple is used for temperature measurements in degree Celsius. The 

thermocouples probe is taped onto the spacers in the test rig to measure the 

material temperature. 

4.1.6 Connectors and cable assemblies 

RG58 coaxial-cable assemblies with BNC plug connectors are used to connect 

the instruments together. The resonant inspection transducers have a SMA jack 

connector on their output. A SMA plug- BNC jack connectors are used to connect 

the transducers to sweep generator output and pre-amplifier input. The instruments 

are connected to each other as shown in figure 4.1. 

4.2 Software Development: 

Software development consists of two parts. 

1. Writing custom software in C/C++ to control HS3 and DS335. 

2. Analysis software in Matlab 

4.2.1. Writing custom software in C/C++ to control HS3 and DS335: 

The HS3 comes is supplied with instrument software supplied by the supplier. 

The instrument software from the supplier has muchfunctionality and is targeted at 

widely varying applications of HS3. The HS3 signal generator cannot sweep in 1 Hz 

steps. Resonant inspection requires 1 Hz steps to identify resonances accurately. The 

typical operating frequency ranges for bolt resonant inspection is 30 kHz - 200 kHz. 

The maximum step resolution of HS3 signal generator is 3 Hz under 50 kHz signal 

frequency. For the signal frequencies above 50kHz, the maximum step resolution of 

HS3 sweep generator is 6Hz until l00kHz and 15Hz there after. Time to sweep over 

a 1 kHz bandwidth is 16 minutes in HS3 at 6Hz resolution. Hence sweep times are 

significant in HS3 and inadequate to be used in resonant inspection. DS335 is a very 

high resolution swept-sine generator capable of stepping through a frequency band in 

Hz steps, which more than meets the requirements in terms of frequency step size. 

The sweep times of DS335 are too fast. A 1 kHz bandwidth sweep takes less 

than 10 seconds, which is fast for the bolt to respond to the frequency. For a 

resonance to be setup in the bolt, the bolt needs to be excited for a sufficient amount 

of time. A very slow sweep is time consuming and practically unviable. HS3 lacks 
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high resolution frequency steps and flexibility. DS335 offers high resolution, but has 

fast sweep times. The solution is to use HS3 as a data acquisition device, and DS335 

as a computer controlled sweep generator. Unlike HS3, DS335 doesn't come with 

instrument software. Instead, all its parameters can be set and controlled via GBIP 

interface using a custom C program. Hence a GBIP - USB adaptor is used to connect 

the DS335 to the USB port of laptop. HS3 can be plugged into another USB port of 

the laptop. 

The software was written in MS Visual Studio environment using Microsoft 

CIC++ compiler. It interacts with the user through a MS-DOS console window. The 

software code can be found in the CD on the rear of the thesis. The program initializes 

the HS3 and DS335 using an appropriate code routine. The software provides two 

modes of operation, Mode 1. HS3 sweep and HS3 log, in which the Handyscope is 

used as a sweep generator and data logger. The program does not compute a FFf; 

instead it calculates the rms (root mean square) values of the bolt response signal. 

Mode 2 is DS335 sweep and HS3 log. In this mode, DS335 is used as the sweep 

generator and HS3 is used as data logger. Mode 1 is used when rms values of the 

signal are needed rather than FFT values which are provided by the supplier software. 

Mode 2 is the main operating mode in RUS. Mode 2 is capable of making the DS335 

sweep in 1, 10, 100, 1000Hz steps. 

4.2.2 HS3 Data Logger: 

The HS3 is controlled through a dll (Dynamic Link Library) file 'hs3.dll'. The 

dll file contains all low level declarations for the function parameters. The USB 

connected HS3 can be controlled by sending and receiving values through functions 

that are defined in the C file ('tiepie.c'), which is linked to the dll file. Functions are 

defined for controlling all of the HS3 functions. The ADCIDAC forms the core of 

HS3, which can be used for data acquisition and signal generation respectively. 

A very fast sweep fails to properly excite and setup resonances in the bolt. To 

adequately excite the bolt, an idling time of not less than 0.4 seconds/Hz is required. 

This was calculated by sweeping the bolt with slow and fast step times, before 

arriving at a nominal value. A number of parameters are set in the HS3 to make it act 

as a data logger. 
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The HS3 is initialised by connecting to the instrument using a manufacturer 

supplied instrument address (Initlnstrument (0x308)). The following parameters are 

set in the HS3. 

a. Sampling frequency: 

25 MHz is set as sampling frequency using SetSampleFrequency( ). The 

frequency range in which the Acoustic Resonant Spectroscopy instrument operates is 

less than 200 kHz. Nyquist frequency for the signal would be 400 kHz. To pick up 

resonances accurately, aRMS measurement is done over the whole acquired signal 

from the receiving transducer. Since the FFT is not used, direct identification of 

frequency content of the signal is of no particular interest. However, the frequency 

content of the signal can be identified alternatively by time domain analysis. The start 

and stop frequencies of a sweep are known. The number of samples (record length) of 

the acquired signal is known. For e.g. a sweep in 10 Hz steps to identify resonances 

between 30000 Hz and 32000 Hz consists of 200 frequency steps. The data logger 

record length is set to 2000. 

Each frequency put out by the sweep generator is converted to an equivalent 

acoustic wave by the input transducer that is in contact with the bolt. The output 

transducer converts any acoustic vibrations it senses in the bolt into an electrical 

equivalent, which is then amplified by the pre-amp and fed to the data logger. The 

data logger digitises the signal and then allows the signal generator to output the next 

frequency. For this particular example, the data logger stores the bolt response for 200 

frequency points, with each signal frequency being represented by 2000 samples, 

which gives a 200000 sample data file. The frequency points in the data file can be 

calculated using the formula 

f = start frequency + (total samples I sample point). 

The rms of each signal frequency is calculated, which gives 200 rms values. The 200 

rms values are plotted against 200 frequency points to obtain a frequency spectrum of 

the acquired data. Since rms is calculated for sine waves, a signal with a very good 

resolution is required. Hence the maximum sampling frequency of 25 MHz is used to 

recover signal information. This is in contrast with using FFT, where it is enough to 

sample the signal at Nyquist rate to recover the frequency content of the signal. 
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b. Record Length 

The record length specifies the length of the acquired signal. It is set to 1000, 

which is enough to acquire a few cycles of sine wave at 30000 Hz (start of operating 

range of the instrument). For the same record length (1000), the number of cycles 

acquired is typically 3 at 30000 Hz and 53 at 100000 Hz. 

c. Resolution 

Resolution is a measure of quantisation steps. A 12-bit resolution provides 212 

quantisation steps. For a 2 V input signal (maximum output of pre-amp ), a 12 bit 

resolution gives 4096 quantisation levels, so the ADC can divide a 2 V signal into 

4096 values. Increasing the resolution resolves the signal better. 

d. Sensitivity 

Sensitivity is set to 8 V. Given that the maximum output of the pre-amp is 2 V, 

a 8 V sensitivity scales the signal to± 8 V. 

e. Measurement channel 

Channel1 (CH1) of the data logger is used to acquisition. 

4.2.3 DS335 Signal generator 

The signal generator is controlled by the program via a GPIB adaptor. The 

DS335 is controlled in a loop along with the data logger by the same program. The 

program sets a frequency output in the DS335 and acquires the response from bolt 

through the data logger. DS335 is initialised by using GPIB command ibdev( ). Any 

initialisation errors are checked for using the command ibsta( ). The parameters that 

are set in the DS335 are frequency and signal voltage. 

a. Frequency 

The program sets a user defined start frequency and sweeps until the stop 

frequency given by the user is reached. A sweep step-size is also specified by 

the user. The program can make the DS335 sweep in 3 step-sizes- 1, 10, and 

100. The GPIB command for setting the frequency in DS335 is 

ibwrt(Dev ,cmd,strlen( cm d)). 

ibwrt - GPIB command for setting the instrument parameter 
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Dev- Device ID. 

Cmd - String Command. Format - FREQ1234567, where 1234567 is the 

frequency to be set. 

b. Voltage 

DS335 can output a signal of 20 Vp-p into a high impedance load. The 

transducer impedance is 1200 Ohm. The program sets DS335 to output 20 Vp-

p. 

c. Frequency count function 

The frequency count function increments the current frequency by the 

specified step size and returns the string to the sweep routine. Sweep routine 

sets the new frequency. 

4.3 Description of the software code: 

Software code is divided into two sections. The instrument control software 

written in C/C++ and the data analysis software. Instrument control software sets 

various instrument parameters, controls the instrument, communicates with the user to 

obtain inputs and stores data in files which are then used by the MATLAB data 

analysis program. 

a. Instrument control software. 

The project file HPResonantlnspection, was developed and tested in MS 

Visual Studio 6 package. The fully annotated software code is attached in 

Annexe A. User manual of the software is attached in Annexe B. 

b. Data Analysis software 

It consists of three parts. The program HPDataAnalaysis processes the data 

file and finds resonances in the data file. The program HPRefineSearch stores 

the sweep bandwidth values in a text file. The values stored are the 

bandwidths that the HPDataAnalysis would sweep next time it is run. The 

program LoadPrediction is a multiple regression algorithm that predicts the 

stress based on the values of input resonances and their fit to the data set. The 
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annotated software codes are attached in Annexe A and the user manual in 

Annexe B contains instructions to operate the MATLAB software. 
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CHAPTERS 

TEST METHODOLOGY 

In this section, outlines of experiments that are needed to study the resonances 

in a bolt are discussed. Results of experiments are then used to calibrate bolts and 

calculate stress. 

5.1 Discussion 

In the initial stages of the project, a laboratory sweep generator, a pair of 

immersion transducers and an oscilloscope was used to study the resonances in the 

bolt. As shown in figure 4.1., a B7 bolt was excited by the immersion transducer and 

analog sweep generator. An oscilloscope connected to the receiving tran.sducer picked 

up the signal. The resonances of the unstressed bolt were seen as progressive 

increases and decreases in the sine wave amplitude. This proved the occurrence of 

resonances in the bolt. The immersion transducers were used because they were 

readily available in the laboratory. Immersion transducers are used in under-water 

ultrasonics and they are highly damped transducers. Hence immersion transducers are 

different from the ultrasonic transducers used in pulse-echo measurements. The 

immersion transducers were characterised using an impedance analyser and its 

resistance was 600 Ohm and capacitance 120 uF. 

The final instrument was a product of continuous development. Each stage of 

experiments provided feedback for enhancing the instrument. A data logger capable 

of operating both as a sweep generator and spectrum analyser was procured. It is the 

Handyscope 3. The HS3 replaced the laboratory sweep generator and the 

oscilloscope. Instead of the sine wave amplitudes that were measured on the 

oscilloscope, HS3 provided a full frequency spectrum view in a given bandwidth. 

The HS3 together with the immersion transducers were used to test the B7 

bolts of 1' 1/8'' diameter and 110 mm length. This was the demonstration part of the 
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project. The aim was to calculate stress in a single bolt in a load cell. The bolt was 

stressed to various levels from 140 KN to 220 KN and the resonances were recorded. 

Those resonances were used to predict stress in the single bolt. The magnitude of shift 

in the resonances for a 20 KN increase in stress was in the order of 30 Hz to 100 Hz. 

For those resonances which had a 30 Hz shift, the accuracy of the HS3 was a concern. 

The step frequency size of the HS3 sweep generator is 24Hz, which would mostly 

mask the 30 Hz shift of the resonances. The sweep times of the HS3 were also 

considerable. A 100 kHz sweep with a 24 Hz frequency step size takes 10 minutes to 

sweep. If there are 4 resonances in a bandwidth of 30 kHz to 100 kHz, for e.g. 2 

resonances between 30 kHz and 40 kHz, 1 resonance between 45 kHz and 50 kHz and 

1 resonance in between 97 kHz and 99 kHz, the HS3 sweeps from 30 kHz to 100 kHz 

to pick all the resonances. HS3 could not sweep in a number of bandwidths but only 

can sweep over a single bandwidth. The DS335 sweep generator replaced the HS3. 

HS3 was then used only as a data logger. 

Successfully calibrating a single bolt was a step forward towards calibrating a 

group of 10 bolts in the load cell and predicting stress in any of the 10 bolts. For the 

tests with 10 bolts, a pre-amplifier was used at the receiving end to boost the signal. 

The group of 10 B7 bolts were 160 mm long with 1' 1/8" diameter. Since the group 

was 50 mm longer than the bolt used in demonstration stage, received signal 

amplitudes were in the order of 2 mV to 20 m V. This amplitude level did not fit with 

the data logger signal input requirements, hence 5113 pre-amp was procured. The pre-

amp band pass filter was capable of blocking signal interference and noise. 

A project plan shown in figure 5.1 (a) and short term work plan as shown in 

figure 5.1 (b), was followed to demonstrate the concept for a single bolt first and then 

for a group of bolts. 
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Figure S.l(b). Short term work plan 

39 



5.2 Testing a single bolt 

A bolt tensioning device supplied by Hedley Purvis Ltd was used to load the 

bolt to various stress levels. A load cell measures the load in the bolt in Newton. A 

detailed view of test rig is shown in figure 5.2 (a). 

Figure 5.2(a). Test Rig with a bolt. 
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The instruments and 1' 1/8" 160 mm B7 bolt are setup as shown below in the figure 

5.2 (b). 
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Figure 5.2(b ). Instrument setup and test rig. 
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5.3 Test procedure: 

a. Load the bolt to a working stress level .. 

b. Look for resonances in the bolt by sweeping over frequency bandwidths 

c. Identify good peaks and note down their frequencies 

d. Increase (or decrease) the bolt stress by 20 KN 

e. Trace the movement of the identified good peaks and note down the new 

(shifted) frequency points. Calculate the magnitude of shifts due to 20 KN 

change in stress 

f. Increase the bolt stress again by 20 KN. Note down the new frequency points 

and magnitude of shift of the peaks. 

g. By analysing resonance data obtained by carrying out above mentioned steps, 

choose useful peaks from good peaks. Those peaks are used to predict stress 

after building a database of resonance information, stress, bolt length and 

temperature. 

5.4 Description of test procedure: 

The bolt is loaded using a bolt tensioner. Bolt load is instantly displayed by 

the load cell measurement system. The working stress range of the bolt type under test 

was obtained from Hedley Purvis technical support team. For the bolt type under test, 

the working range is between 180 KN to 220 KN. The bolt is initially loaded to 180 

KN. The instruments and connections are setup as shown in figure 5.2(b). A 

frequency sweep is done from DC - 100 kHz using HS3 sweep generator. 

Peaks in the frequency spectrum are noted down. By zooming in on the peaks, 

the symmetry of each peak can be examined. Peaks with good symmetry and high 

relative amplitude are usually good peaks. This is known by practice. The lower cut-

off of the pre-amp band pass filter is set to 30 kHz and the upper cut-off is set to 100 

kHz. This helps to reduce the noise from audible sources in an industrial environment, 

where tests were carried out. 

The load is increased by 20 KN and a frequency sweep is done over a 

bandwidth of 30 kHz - 100 kHz. The frequency spectrum is examined for the shifts in 

the peaks that were noted down in the previous step. Since change in stress affects 
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resonance,.some of the resonances shift and some do not. The shift is usually positive. 

This is discussed in the experiments section. 
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CHAPTER6 

EXPERIMENTS 

This section describes the experimental process that is used to calculate stress in bolts. 

The experiments are carried out using the instruments setup test methodology 

described in chapter 5. 

6.1 Bolt Parameters 

All the bolts used in experiments follow these specifications. 

Bolt Type: B7 

Length: 160 mm 

Diameter: 1' 1/8' ' 

Temperature: Room temperature varying from 17 Celsius to 21 Celsius 

Top extension length: 90 mm above the test rig surface 

Load on bolt: Varying from 0 KN to 240 KN 

The natural variation of resonant frequencies within bolts of a given nominal 

specification has been characterised. However, the parameters which cause this 

required further investigation. In this study, the variation in the speed of sound and 

Young's modulus are characterised [13]. 

6.2 Speed of sound 

The work described in this section was carried out by R Handford at Durham 

University [13]. 

6.2.1 Unstressed bolt 

Assuming the material is linear the following equation applies 

f =frequency 

f =vI lambda(1) 

Hz 
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v = speed of sound 

lambda = wavelength m (this is dependent on length of bolt and number 

of the harmonic) 

To find the speed of sound, pulses were transmitted down the bolt and the 

times taken for them to hit the backwall and return were measured. This was carried 

out seven times for ten different bolts. 

The bolt lengths at zero loads were measured using a vernier, which is 

accurate to 1/10th of a millimetre. Time-of-flight measurements were carried out on 

each bolt and the velocity was calculated using the formula v = distance I time. The 

results showed the average value for the speed of sound was 5917m/s with a standard 

deviation of 2.7m/s. This experiment was done to account for any natural variations in 

speed of sound in an unstressed bolt. When resonance measurements were carried out 

in the group of 10 unstressed, similar bolts, the standard deviation across the 

resonances were± 20Hz. The time-of-flight experiment is an attempt to characterise 

the variation in speed of sound in the same group of 10 unstressed, similar bolts. An 

attempt was made to relate the time domain data to the frequency domain resonance 

data. Theoretical resonant frequencies calculated using time-of-flight measurements 

have standard deviation of ±16Hz across the 10 bolts. This compares, to the± 20Hz 

obtained by resonant inspection. While both the pulse-echo and resonant tests indicate 

there are natural variations in bolts at zero load the variation is ± 20 Hz , which has 

minimal effect on the actual bolt testing described in Section 6.3 

6.2.2 Tensioned bolt 

Experiments were carried out on one randomly selected bolt to look at how the speed 

of sound varied with stress. To obtain accurate values for the speed it was also 

necessary to measure the strain of the bolt, these values were then used to provide a 

stress strain graph as in Figure 6.2 (a). This was done to give confidence in the 

velocity graph. 
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Stress Strain Graph 
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Figure 6.2(a) Stress- Strain Graph 

The graph is linear as expected and give a Young's Modulus of about 

180Gpa, which is similar to that quoted for steel, however this is not necessarily an 

accurate value as the bolt area was estimated and it assumes the whole bolt length is 

being stressed. 
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Figure 6.2(b) Variation of speed of sound with stresses. 
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This graph in figure 6.2 (b) shows how the speed of sound varies as the stress applied 

to the bolt is increased. It shows that as the load is increased the speed of sound 

decreases. 

The fact that the length of the bolt increases and that the speed of sound 

decreases as the bolt is stretched despite an increase in the frequencies of the resonant 

peaks shows that the formula f =vI lambda applies only to phase velocity and not the 

group velocity which is measured by the ultrasonic instrument. That could explain 

why there are positive shifts in resonances inreal-time when a bolt is stressed, in-spite 

of the equation f = vI lambda producing negative shifts for increase in bolt length due 

to stress. However, the exact causes need to be investigated further and at this stage it 

was decided to take the project further by considering the fact that 99% of the 

observed resonances had a positive shift with an increase in stress and 1% had random 

positive and negative shifts with increase in stress. 

Parameters such as bolt length, diameter and extension above the spacers i.e. 

bolt position, temperature are constant or nearly the same in all test conditions. The 

only varying parameter is stress. Hence the shifts in resonances relate to stress. The 

shifts are repeatable and hence stress can be predicted with reasonably good accuracy. 

An experiment to measure stress in a single bolt is discussed in the following section. 

6.3. Experiments with single bolt 

The bolt is loaded at 0 KN. A swept frequency analysis is carried out and a 

frequency spectrum of the bolt response is obtained. The following figure 6.3 (a) 

shows the bolt resonances at zero stress. 
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Figure 6.3(a) Resonance spectrum of a B7 bolt at 0 KN 

The resonances were compared with the theoretical resonances obtained by using the 

formula f = v I lambda. The results are as follows in the graph 6.3 (b). 

48 



Theortical vs Observed Resonances 

300 

250 

~ 
200 

• Theoritical resonance 
• ObseJVed Resonance 

(; 
m :s 
~ u. 

100 

50 

0 
0 5 10 15 20 25 30 

Resonance number 

Table 6.3 (b) Comparison of theoretical and observed resonances. 

The theoretical and observed resonances do not match fully. The scope of this 

project is to develop a working instrument to measure stress in bolts, hence only 

minimal work has been done on the background theory on the resonances in bolt. 

However the core concept of the project i.e. shifts in resonances due to change in 

stress has been studied and verified. 

The frequency spectrum of the bolt at 0 KN load and 100 KN load are 

compared in the figure 6.3 (c) to show the shift in resonances due to increase in stress. 

The resonances at 0 KN load are characterised by relatively high amplitudes and 

linear occurrence. The resonances at 100 KN are of lesser amplitude and shifted to the 

right from their position at 0 KN. Increase in the stress causes peak splits and non-

linear occurrences of resonance. But the obtained spectrum is repeatable in standard 

test conditions. Attenuation of resonances leads to the use of low noise voltage pre-

amp at the receiving end. It can also be noted that the magnitude of shift for each 

resonance frequency is not uniform. Hence some resonances shift more than the other 

resonances. Some resonances have very negligible shift or in some instances do not 

shift. The mapping of resonances to the stress level of the bolt is important to predict 

stress. 
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According to the confidence level in each peak, some of the peaks are selected 

as indicators of stress in the bolt. The key to confidence level in a peak is its 

magnitude of shift due to increase in stress and also its repeatability. If a peak has 

shifts in the order of 100 to 300Hz and if it occurs at± 50Hz every time the bolt is 

stressed to the same level, the peak can be selected as an indicator of stress. Another 

factor is peak splitting. If a peak splits at a certain stress level in working range of the 

bolt, the peak has less possibility of being used as stress indicator due to the 

inaccuracies that the peak split adds while determining its position, which is in turn 

used to predict stress. 

The preceding discussion establishes the presence of resonances in the bolt 

under test and validates the shifts in resonances when the bolt is stressed. It also 

proves that the instrument used has the capability to successfully measure resonances. 

The shifts can be related back to the stress in the bolt. However there are certain other 

factors that influence the outcome of stress prediction. They are temperature, position 

of the bolt, length of the bolt, relaxation effect on the bolt immediately after 

tightening, time period of excitation at each frequency and effect of transducer 

placement on the ends of the bolt. These factors can influence the resonances in the 

bolt and hence their effects are studied with an aim of compensating for variations 

caused by them. 

a. Effect of temperature: 

Temperature affects material properties of steel. Sound travels faster in a hot 

medium and slower in a cold medium. Temperature effects on resonances have been 

extensively studied [6]. An increase in temperature causes a backward shift in the 

resonances. A decrease causes a forward shift. Resonance shifts are inversely 

proportional to temperature. It is important to characterise the variations in resonances 

due to temperature changes because a significant increase in temperature can offset 

the effect of stress on the resonances. 
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Bolt 
extensio Temper Load( 
n(mm) ature(C) KN) F1 (Hz) F2(Hz) F3(Hz) F4(Hz) F5(Hz) F6(Hz) 

109 17.7 204 33330 35010 35390 42850 44480 99510 

109 17.9 204 33330 35020 35390 42850 44480 99510 

109 18 204 33330 35020 35390 42830 44480 99510 

109 18.3 204 33320 35020 35380 42830 44480 99490 

109 18.8 204 33320 35010 35380 42830 44470 99490 

109 19 204 33310 35010 35370 42820 44460 99480 

109 19.2 204 33310 35010 35370 42820 44460 99480 

109 19.8 204 33310 35020 35370 42820 44460 99480 

Table 6.3 (d) Resonance variations with temperature 

The table 6.3 (d) contains resonance data taken at a constant load of 204 KN, 

but at varying temperatures from 17.7 C to 19. 8, indicative of typical room 

temperature levels. The average shift of resonances for a 2 C increase in temperature 

is - 20 Hz or + 20 Hz for a 2 C decrease in temperature. The resonances are plotted 

against temperature changes to study the variations caused by temperature change. 
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Figure 6.3(e) Change in resonant frequency·t with temperatures 
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Figure 6.3(f) Change in resonant frequency 5 with temperatures 

The graphs 6.3 (e) and 6.3 (f) show an inversely proportional relationship 

between resonance and temperature. A 2 C change in temperature causes an average 

20Hz shift, which isn't a significant shift when compared to an average 100-200 Hz 

shift caused by increase in stress by 30 KN. So the temperature should change by 10 

C to offset the effect of 30 KN increase in stress. A 10 C change is not possible in lab 

conditions. Due to lack of an environmental chamber to study the resonances at higher 

and lower temperatures, characterising temperature variations is left at this point. It is 

stressed that, 2 - 3 C changes in room temperature would not affect the stress 

prediction significantly. 

b. Length of the bolt 

The length of the bolt affects resonances. However in a typical real-time 

flange where this instrument would find its use, all the bolts are within ± 0.5 mm 

length. The bolts that were used for this project all had their length variations within ± 

0.5 mm. The lengths of the 10 bolts used in this project and their resonances at zero 

stress are shown in the following table 6.3 (g). 
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BOLT Length 
NO F1 Hz F2 Hz F3Hz F4 Hz F5 Hz F6 Hz F7Hz F8Hz F9 Hz mm 

1 34031 40654 47233 53845 60317 66698 72940 79019 84895 160.54 

2 34049 40757 47405 53987 60489 66886 73144 79237 85136 159.04 

3 34084 40788 47423 54027 60518 66918 73180 79275 85170 159.10 

4 34201 40793 47514 54099 60579 66966 73217 79301 85209 159.04 

5 34103 40791 47431 54042 60543 66953 73211 79305 85203 159.16 

6 34252 40795 47474 54121 60613 66999 73254 79348 85244 159.14 

7 34113 40779 47443 54059 60557 66963 73223 79322 85224 159.22 

8 34182 40793 47469 54089 60581 66983 73237 79332 85219 159.16 

9 34164 40831 47421 54065 60563 66964 73227 79321 85221 159.18 

10 34166 40826 47430 54064 60554 66964 73216 79308 85200 159.40 

Table 6.3(g) Resonances of group of 10 bolts at 0 stress, with lengths ± 0.5 mm 

From the table 6.3(g), at 0 KN, the standard deviation across all resonances 

average out to 20 Hz. Hence a length variation of± 0.5 mm among the 10 bolts causes 

a deviation of 20 Hz, which is less compared to the average resonance shifts of 150 

Hz for a 30 KN change in load. 

c. Position of bolt 

The position of bolt is its extension lengths on the either side of the spacers. 

The distance between two spacers (which simulate a flange), is constant. At a given 

stress, the resonances are repeatable only if the extension position of the bolt remains 

the same. A change in bolt extension position effects a change in resonances. To study 

the variations caused by bolt extension position, the load is kept constant and 

extension position of the bolt is varied. The resonances are measured and a method of 

compensation for variation in extension position is identified. 
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Figure 6.3(h) Bolt extension on left rig is different from the extension of right. 

Top extension 
mm F1 Hz F2 Hz F3 Hz F4 Hz F5Hz 
109 33200 34980 35330 44340 98970 
115 32960 34980 35320 44270 99180 
120 32740 34680 35350 44400 98610 
125 32430 34530 35360 44080 98720 
130 32020 34310 35410 43910 98660 
135 31380 34000 35300 44040 99220 
140 31380 34220 35460 43870 98550 

Table 6.3(i) Load 172 KN 
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Top extension 
mm F1 Hz F2 Hz F3 Hz F4Hz F5 Hz 
109 33330 35040 35360 99590 44500 
115 32970 34890 35350 99230 44340 
120 32650 34700 35350 99080 44540 
125 32450 34570 35410 98840 44200 
130 31930 34430 35430 99420 44410 
135 31530 34500 35440 99350 45810 
140 31450 34300 35450 98880 44380 

Table 6.3(j) Load 200 KN 

The tables 6.3 (h) and 6.3 (i) consist of resonances of the bolt at a given load 

but at different top extension lengths. The extension position starts at 109 mm. The 

length of the bolt on the either side of the spacer is equal when the top and bottom 

extension is 109 mm. The bolt is initially adjusted so that its length on the either side 

of the spacer is the same and then for each subsequent measurement the length of the 

bolt on the top of the. spacer is increased gradually. The variations in the resonances 

due to extension position are plotted at 3 different loads, 150 KN (table not given), 

172 KN, 200 KN. 
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Figure 6.3 (k) Bolt extension position data 
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A plot is obtained by the plotting the first resonant frequency against the 

extension lengths, at load 172 KN. A straight line fit is done on the data and an 

equation of best fit is obtained. Then, the first resonance values obtained at loads 150 

KN and 200 KN are applied to the equation that was obtained by fitting the resonance 

data at 172 KN. When those three data sets are plotted against extension lengths, the 

above figure 6.3 (j) is obtained. From the plot it can be seen that the slope of the 

resonance data is nearly the same. Also there is an offset between the three data sets 

which can be related to stress. To compensate for the bolt extension position, the 

resonance and bolt extension position of the bolt under test is measured. They are 

applied to the equation of straight line fit to obtain a compensated resonance value. In 

this project, the bolt extension position has been kept constant in all the tests and the 

instrument is capable of predicting stress only for bolts that have same bolt extension 

position of the data set. Extending the compensation procedure from one bolt to 10 

bolts is time consuming and complex hence this part has been identified as future 

work. 

d. Relaxation effect 

Immediately after the bolt is tightened, the bolt load decreases for a certain 

time before it settles. This is known as the relaxation effect. During initial periods of 

testing the resonances were measured randomly in time, after the bolt has been 

tightened. Resonances were at times non-repeatable at the same given load, 

temperature and extension position. Hence the effect of relaxation was investigated 

and it was found that the resonance values also change when the load decreases 

gradually. The resonance settles with the load. Hence resonances are measured after 5 

- 10 minutes after the bolt is tightened. But this is not necessary in real-time flange 

testing, because in almost all flange testing applications, the bolt would have been 

tightened long before the testing is carried out. 

e. Time of excitation 

Time of excitation is the amount of time that each frequency is used to excite 

the bolt before the next frequency is output from the sweep generator [9]. To obtain 

accurate frequency spectrum information of the bolt, it is important to excite the bolt 

at each frequency for an adequate amount of time. This issue was identified while 

programming the sweep generator. The software loop in the control software was first 
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written to step through each frequency randomly or as determined by the number of 

processes running in the computer's microprocessor. This gave out random resonance 

frequency spectrum every time a sweep was made. Hence a delay loop was added to 

the program to make the sweep generator output a certain frequency for the time 

specified by the delay loop and then step through the next frequency followed by a 

delay and so on. The delay time was calculated by trial and error. Since there was no 

known method to determine the least possible delay time required to excite a bolt to 

get reliable resonance information, trial and error was used. The delay time was 

increased gradually from zero until the obtained resonance spectrum was repeatable 

every time. 

f. Transducer placement 

The effect of transducer placement was studied by swapping the transmitting 

and receiving ends to the either side of the bolt. The transmitted end was now the 

receiving end and vice versa. The results obtained were same. Hence resonances 

induced in the bolt are not determined by the side of excitation or reception. 

Temp Load F1 F2 F3 F4 F5 F6 oc KN Hz Hz Hz Hz Hz Hz 
Top 
Transmitter 20.8 187.62 33200 34950 35330 42710 44390 99100 
Bottom 
Transmitter 20.7 187.65 33190 34950 35330 42710 44400 99090 

Table 6.3(1) Transducer placement 

6.4 Predicting stress in single bolt 

From the preceding discussions, it has been established that resonant shifts can 

be related to stress. However factors such as temperature, bolt position need to be 

compensated. It was discussed that temperature variations within the laboratory affect 

the resonance marginally. Bolt position need further extensive testing before a model 

can be developed to compensate for it. Hence bolt position is kept constant in this 

project. This leaves us with two significant variables, load i.e. stress and resonances. 

For predicting stress in a single bolt a database of various loads and their 

corresponding resonances is built. Before stress can be predicted in a bolt, the bolt is 
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tested at various loads within the typical working range of the bolt. The resonant 

frequencies at each load are noted down and a database is formed. The table 6.4 (a) 

below is a database formed for predicting stress in a B7 bolt of length 160 mm, 1' 

1/8" diameter, in a test rig. This dataset is used as a data source for the MATLAB 

algorithm that performs a multiple regression analysis to predict stress. The regression 

algorithm accepts the 3 resonant frequencies as input and predicts a load. The 3 

resonant frequencies are measured by sweeping through 3 bandwidths that contain the 

three resonances in the data set. For this data set the typical sweep bandwidths would 

be 30kHz-34kHz, 41 k:Hz- 45 k:Hz and 97kHz- 99500 kHz. Temperature data is 

measured but not used in stress prediction. The predicted load is within ± 10% of the 

actual load using the above method. 
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LOAD(KN) FREQl(Hz) FREQ2Hz FREQ3Hz TEMP( C) 

142.12 32590 43610 98794 19.3 
147.85 32789 43230 98755 19.7 
149 32693 43111 98525 18.5 
152.78 32295 43181 98330 18.5 
160.11 32711 43810 98944 19.4 
163.99 32988 43270 98861 19 
167.5 32826 43350 98884 19.9 
167.94 32801 43477 98752 18.7 
170.75 32389 43381 98437 18.6 
170.9 32770 43780 98735 19 
171.04 32760 43932 99038 19.2 
178 32815 43684 98858 19.3 
179.5 32832 43570 98802 18.7 
180.2 32859 43472 98947 20 
183.29 32785 43830 98753 19 
184.65 33028 43350 98930 19 
185.8 32520 43545 98501 19.1 
185.83 32838 44042 99098 19.2 

191.95 32842 43663 98872 18.3 
192.08 32847 43750 98936 19.4 
193.15 32895 43580 98997 20 
196.55 32752 43910 98792 19 
197.04 32632 43649 98547 19 
198.65 33036 43440 98985 19 
204.28 32887 43825 99021 19.3 

Table 6.4(a) Data set for predicting stress in a single bolt 
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6.5 Measurement of bolt stress in a group of 10 Bolts 

The single bolt that was used in initially testing is a part of a 10 bolt set. Stress 

can be measured in a group of 10 bolts using the same methodology that was followed 

while testing a single bolt. Instead of a single bolt, ten single bolts are tested. A 

common calibration dataset is built using the load and resonance values obtained from 

each of the 10 bolts. The data set for a single bolt contained 25 load values. The 

calibration data set for the 10 bolts has about 40 load values, 4 for each bolt. This 

generalisation is possible because all the bolts are made from the same material and 

have the same nominal dimensions. They all have same extension lengths on the 

either side of the spacers and the effect of temperature is marginal. A calibration data 

set shown in the table 6.5(a) is used to predict stress in a group of 10 bolts. If the load 

in the bolt under test is within the range of loads present in the data set, a stress 

prediction accuracy of ±15-20% can be obtained. The larger the data set, the better the 

accuracy. Any of the 10 bolts in the group can be picked and the stress can be 

predicted. While picking one of the 10 bolts, the process becomes generalised because 

there is no previous knowledge of the particular bolt except for the data set that has 

been built using the 10 similar bolts. 

LoadKN FlHz F2Hz F3Hz 

163 32627 44253 98521 

163.01 32756 44289 98517 

166.66 32668 44094 98320 

169.96 32733 44246 98633 

174.52 32808 44316 98658 

175.4 32839 44197 98596 

178.95 32684 44356 98613 

179.77 32778 44226 98564 

183.4 32687 44185 98365 

184.64 32781 44423 98716 

187.05 32687 44306 98584 

187.95 32803 44123 98571 

191 32778 44448 98660 
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192.38 32875 44280 98736 

194.68 32703 44248 98386 

196.45 32857 44419 98754 

197.27 32791 44568 98852 

203.55 32792 44513 98676 

203.67 32754 44486 98800 

207.32 32817 44593 98898 

207.94 32793 44419 98778 

208.05 32868 44255 98609 

208.51 32845 44506 98832 

210.83 32750 44279 98398 

212.08 32934 44379 98823 

212.62 32879 44479 98812 

212.96 32784 44558 98685 

215.9 32833 44509 98872 

219.12 32838 44615 98930 

222.74 32825 44505 98847 

224.67 32869 44565 98910 

226.33 32905 44334 98623 

227.25 32969 44483 98921 

227.77 32897 44518 98877 

233.14 32850 44631 98983 

235.82 32853 44545 98906 

Table 6.5(a) Calibration data set used to predict stress in group of 10 bolts. 

This dataset is used as a data source for the MATLAB algorithm that performs a 

multiple regression analysis to predict stress. The regression algorithm accepts the 3 

resonant frequencies as input and predicts a load. The 3 resonant frequencies are 

measured by sweeping through 3 bandwidths that contain the three resonances in the 

data set. For this data set the typical sweep bandwidths would be 30kHz-34kHz, 41 

kHz - 45 kHz and 97 kHz - 99500 kHz. 
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Figure 6.5(b ): Graph of calibration data. 
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The matlab algorithm for stress prediction and calculating error prediction is as 

follows: 

% Read the calibration data stored in the text file % 

data= dlmread('C:\HP Resonantlnspection\regmodeldur.txt'); 

%Store load (kN), Fl (Hz), F2 (Hz), F3 (Hz), Length (mm) to corresponding 

variables% 

load= data(:,1); 

data(:,[l]) = [ ]; 

f1 = data(:,1); 

f2 = data(:,2); 

f3 = data(:,3); 

X= [ones(size(fl)) f1 f2 f3]; 

%Generates coefficients of best fit for the calibration data set% 

a= X\load; 

Y=X*a; 

%Gives the maximum error for the given calibration data set% 

MaxErr = max(abs(Y -load)); 

The MaxErr value for the calibration data set is 36, which is 36 kN. For example, if 

the actual bolt load is 180 kN, the prediction algorithm can have a maximum possible 

error of 36 kN. Hence 36 kN error for an actual load of 180 kN gives an accuracy of 

±20%. 

%Obtain the measured resonant frequencies from the user % 

resfreq01 = input('Enter the first resonant frequency in Hz'); 

resfreq02 = input('Enter the first resonant frequency in Hz'); 

resfreq03 = input('Enter the first resonant frequency in Hz'); 

F = [resfreq01 resfreq02 resfreq03]; 
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%Calculate prediced load by multiplying measured resonance and length values 

with calculated regression equation coefficients% 

predictedload = a(l,l)+a(2,1)*F(l,l)+a(3,1)*F(l,2)+a(4,1)*F(l,3); 

%Print the calculated load value% 

fprintf('Predicted Load %d KN \n', int16(predictedload)); 

The above program obtains the three resonant frequencies as input from the user and 

those values are multiplied by the regression coefficients calculated using a least 

squares fit on the calibration data to predict stress. A detailed description of the 

process of operating the software and measuring resonances is provided in the user 

manual attached in Annexe B. The user manual provides a step by step approach to 

predict stress in a group of B7 bolts using the RUS instrument. 
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CHAPTER 7 

CONCLUSION 

An instrument capable of predicting stress in bolts was developed and tested. 

The instrument operates on the principle of shifts in resonances due to change in 

stress. Resonances have been used in non-destructive testing applications such as 

defect detection and characterisation of material properties. This project is the first to 

use resonances in predicting bolt stress. As with any new technology, there are 

limitations and areas of future work in Resonant Ultrasound Spectroscopy. The two 

main areas of the project are instrument development and experiments. The 

experiments and instrument development were done in a loop, with the experiment 

results feeding back to the development of accurate instrumentation. 

A project plan and short term work plan were used to do the project. The 

project was started with basic laboratory hand-operated equipment such as sine wave 

generator, immersion transducers and an oscilloscope. The final instrument is a highly 

accurate, automated, software controlled instrument which can measure resonances to 

1 Hz accuracy. The current instrument although accurate, is not intrinsically safe. 

Also it is not a hand-held device. Hence work has to be done on making it intrinsically 

safe and hand-held to have a wider market appeal. The software code consists of two 

parts. A C!C++ software controls the instruments and acquire the frequency response 

of the bolt. The MA TLAB software processes the digital signal and picks the 

resonances from the frequency response of the bolt. It also predicts stress using a 

multiple regression algorithm. 

The instrument at this stage cannot be used in a real- time flange. The results 

of the tests done on the flange have shown that the stress prediction process that 

works well on a test rig bolt cannot be used as such on a flange. This is an area of 

future work, which would open up the flange condition monitoring market to this 

instrument. Another area of future work is the bolt extension position. Throughout 

this project, bolt extension position has been kept constant while building the data 

sets. Work has been done on identifying a method of compensation; however time 
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limitations have led to assigning this work to future. Temperature compensation is 

also required to be done before the instrument can be used in non-laboratory 

conditions. A method of compensation has been identified based on the linear 

relationship between resonances and temperature, but the lack of an environmental 

chamber has led to postponing of temperature compensation tests. 

Using the RUS instrument, stress can be predicted in a single bolt to± 10% of 

the actual stress. For a group of 10 bolts, the average stress prediction accuracy is ± 

20%. The current ultrasound pulse-echo instruments which are used to calculate bolt 

stress based on the bolt elongation after tightening, have a claimed accuracy of± 5%. 

But the pulse-echo instruments require measurement on the bolts before and after 

tightening to predict stress. Also the claimed accuracy of± 5% has been found to be 

inaccurate by the technicians of Hedley Purvis Ltd at several occasions of testing. The 

realistic accuracy of pulse-echo instruments are in the range of ± 10 - 15%. RUS 

instrument does not require measurements to be done on the bolt under test before and 

after tightening. This instrument relies on the dataset of 'similar' bolt data that has 

been built, tested and verified. The value of the RUS instrument is due to its ability to 

predict stress in an 'unknown' bolt. A B7 bolt which has been in place for several 

years and has no recorded history of pulse-echo data, is a target of the R US 

instrument. RUS can also be used in condition monitoring of flanges, where the stress 

of individual bolts can be monitored over the course of time to provide accurate 

information of change in bolt stress across the flange. British Petroleum has expressed 

particular interest in using RUS for condition monitoring. 

In this project, a new method has been developed to predict stress in bolts 

using shifts in resonances. Apart from stress, other factors that affect resonances have 

been investigated and means of compensation identified. A suitable instrument to 

excite the bolt and measure resonances to predict stress has been built. An accuracy of 

± 20% has been achieved with a group of 10 B7 bolts. 
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Annexe A 

Software Code 

The DVD contains CIC++ program files and MATLAB program files. They are 

stored as text files to make it easy to view them. The DVD also contains pictures of 

the individual instruments and hardware manuals. 

File Description 

1. hpresonantinspection - CIC++ Instrument control software 

2. HPDataAnalysis- MATLAB Software to process the acquired data and pick 

resonances 

3. HPRefineSearch - MATLAB program to store user selected sweep 

bandwidths 

4. Loadprediction - MATLAB program to perform regression analysis and 

predict load. 
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AnnexeB 

Resonant Inspection Operating Manual 

Contents 

1. Quick start guide 

2. Instrument setup 

2.1 Load cell setup 

2.2 Connectors and cable setup 

2.3 Oscilloscope and thermocouple setup 

2.4 DS335 sweep generator setup 

2.5 5113 Preamplifier setup 

2.6 HS3 Setup 

3. Finding useful resonances 

3.1 Level of confidence in peaks 

4. Building a calibration data set 

4.1 Software setup 

4.2 Running the program 

4.3 MATLAB data analysis 

4.4 Running the MATLAB program 

5. Load prediction using the calibration data set 

6. Troubleshooting 

6.1 HS3 

6.2 Pre-amplifier 

6.2 HPDataAnalysis 

Figures: 

FIGURE 1.1- Test rig diagram with HS3 as sweep generator 

FIGURE 4.1 - Test rig diagram with DS335 as sweep generator 

FIGURE 4.2 - Calibration data set table. 
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SECTION 1- QUICK START GUIDE 

To build a calibration data set of a new set of bolts, identify useful 

resonances of the bolt using HS3 and for each bolt in the data set, find the 

resonances to 1 Hz or 10 Hz accuracy. 

1. Setup the test rig as shown in figure 1. 

2. Load the bolt to a suitable stress level (e.g. 180 KN) 

3. Setup the instruments (refer section 2) 

4. Find useful resonances (refer section 3 &4) 

5. Make DS335 as sweep generator (refer Figure 2) 

6. Build calibration data set as explained in section 5. Repeat section 5 for all the 

bolts at different loads to the build the data set 

7. Predict Load (refer section 5) 

Check List of instruments: 

1. Resonant inspection probes - 2 

2. Probe holders - 2 

3. SMA- BNC Connectors - 2 

4. BNC- BNC co-axial cables . 

5. Stanford Research DS335 sine wave generator & GPIB-USB adaptor 

6. Handyscope- HS3 Data Logger 

7. Digital Storage Oscilloscope 

8. Low noise voltage pre-amplifier & Power supply adaptor 

9. Load transducer 

10. Thermocouple 
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2.1 Load cell setup 

The load cell is setup as shown in the figure. Probe holders are screwed 

on to the either ends on the bolt. The RI (Resonant inspection) probes are 

screwed on to the probe holders. Probes are adjusted at the point of contact 

with the bolt so that the probe tips are in full contact with the bolt surface. If 

the bolt surface at the point of contact has bumps, uneven surface or other 

anomalies, the surface must be prepared to a suitable standard before testing. 

The point of contact should be even, without any rust, bumps or pits. 

2.2 Connectors and Cables 

The load transducer cable (in between two spacers) is connected to the 

rear of the measurement box. A suitable connector is provided at the rear of 

box. 

The two SMA (Male) -BNC (Female) connectors are screwed on to 

the ends of two RI probes. Two BNC (M) - BNC (M) cables are connected to 

the BNC (F) ends of the connectors attached to the probes. 

The other end of thecable from the transmit probe is connected to the 

'OUT' of the Handyscope 3(HS3). The other end of the cable from receive 

probe is connected to 'A' input of the voltage pre-amplifier. The output of the 

pre-amplifier is connected to the 'CHl' of the HS3 using a BNC-BNC cable. 

The USB cable behind the HS3 is connected to the computer USB port. The 

power supply cable behind the HS3 is connected to the PS2 port 

(mouse/keyboard port) of the computer. The Low noise voltage amplifier is 

connected to the power supply via a power adaptor and switched ON. 

2.3 Oscilloscope and thermocouple setup 

1. The oscilloscope is connected to the power supply and switched ON. It 

is used only if necessary. 

2. Thermocouple probe is taped to the upper spacer and switched ON. 
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2.4 DS335 setup 

a. The GPIB - USB interface is connected to the rear of the DS335 and 

the USB end is plugged to the computer. 

b. DS335 is connected to power supply and switched ON 

2.5 Pre-amplifier setup 

Coupling mode: A ls (By pressing the 'Input Coupling' button) 

Filter :30KHz (Use LF Roll off)- 300KHz (Use HF Roll 

off) 

Gain : 500 or appropriate to signal amplitude 

2.6 HS3 setup 

Open HS3 software by clicking on the 'Handyscope 3 v2.52' icon on 

the Desktop or Start -> All Programs -> Handyscope 3. If a dialog appears 

saying 'No instrument found, click 'Close'. Again open 'Handyscope 3 v2.52 

by clicking on it. The HS3 should work now. Click on the spectrum analyser. 

Close the oscilloscope. Click on the Generator. 

In the spectrum analyser click File-> Load Instrument settings. 

Browse to the location of the saved settings file and click OK to load the 

settings on to the spectrum analyser. 

OR 

Make the following settings in the HS3 and save them for future use. 

1. File 

a. Save Instrument setting: Used to save the instrument setting for 

future use. Settings, once saved, can be loaded easily using Restore 

Instrument Setting. 
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b. Data File Type- select 'ASCII' 

c. Write waveform to disk - Used to save the spectrum as a data file in 

the hard disk. Four files are created for a save. filename.DAT, 

filename.GEG, filename.REF and filename.FFT. The filename.FFT 

contains frequency and voltage data, which can be imported into 

MATLAB or Excel for further analysis. Other three files are not used. 

d. Save Image - For saving the image of the spectrum to the hard disk. 

2. Measure 

a. CHl - For measuring the signals from CHI. Similarly CH2 for CH2 

measurement and CHI & CH2 for simultaneous measurement. Usually 

CHI is used. 

b. Perform Averaging of - Used to reduce error by averaging the 

acquired signal. Since HS3 is used only to get a picture of spectrum, I 

averaging is ok. Increasing the averaging increases time taken for 

measurements and increases accuracy. 

c. Measure Maximum Values - It is selected for resonant inspection 

measurements. Unselecting it makes only the instantaneous values of 

the spectrum available. 

3. CHl 
a. Sensitivity - Sensitivity is set according to the signal level at input. 

2V, 4V, 8V are the usual values used in RI. Signal level can be 

measured using an oscilloscope or by trial and error on the spectrum 

analyser. If the signal voltage is much more than sensitivity level, the 

signal is clipped and distortion introduced in the spectrum. 

b. Signal coupling - Coupling AC 

c. Software Gain - I. Increase if a software amplification of the signal is 

required. 

d. Software offset- 0. 

e. Axis Type - Linear 

f. Units of measure - Volts 

g. Units Gain - I. 

h. Units offset- 0. 
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4. Frequency Axis 

a. Frequency Range: To set the required frequency range for 

measurement. For a sweep, frequency range is usually set in the sweep 

generator. Hence this can be ignored. 

b. Record Length: Record length determines frequency resolution. 

Below 100kHz, 4096 gives 24Hz resolution. Above 100kHz, 8196 

gives 30 Hz resolution. These two are the usually used record lengths. 

A higher or lower record length may be chosen to get a higher or lower 

frequency resolution. High record lengths take longer to sweep and 

vice versa. 

c. Record View Gain - 1. 

d. Axis Type - Linear 

5. Cursors 

a. Select appropriate cursors to measure the values in the spectrum. Both 

large and small cursors do the same thing. 

6. Settings 

a. FFT function - Select an appropriate window. Usually Blackrnan-

Harris window is used. 

b. Vertical Log axis range - Clipped to confirm hardware specs 

c. Interpolation - ON 

Signal Generator Settings 

On the instrument selection panel of the HS3, select 'Generator' to 

enable the Signal Generator. Select 'Sine'. Set Amplitude to '10V' and 

Symmetry to 'Mid' and DC Offset to 0. 

Click on the 'Sweep' button. When a frequency sweep is to be 

performed, select 'Manual' in the sweep generator settings. Enter Start and 

Stop frequencies in Hz. Enable 'Frequency Sweep related to spectrum length'. 

Click Continue to complete the sweep generator settings. There is an ON/OFF 

button for the Sweep. If the spectrum analyser is left turned ON, the spectrum 

analyser can be controlled by the ON/OFF button of the sweep generator. 
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After making all the settings, save the settings for future use. The 

settings file can be reloaded into the HS3, without having to redo all the 

settings again. Variable parameters for the RI sweeps are usually the record 

length (to change frequency resolution), sensitivity (to match the signal level), 

start and stop frequencies in the sweep generator. 

The HS3 is used as a signal generator and data analysis device for 

identifying useful resonant frequencies in a new bolt. After identifying the 

useful resonances using HS3, DS335 is used as a signal generator and 

MATLAB is used for signal analysis. 

SECTION 3 - FINDING USEFUL RESONANCES. 

The bolt is loaded up to for e.g.180 KN. A sweep in the frequency 

range of 30KHz- 100KHz is carried out first. The start (30KHz) and stop 

(100 KHz) frequencies are entered in the sweep generator. The sweep 

generator is switched ON, and the spectrum analyser plots the response of the 

bolt for each frequency sent out by the generator. Stop the sweep generator 

after it sweeps through to 100 KHz. 

The spectrum is analysed for resonant peaks. The peaks that are well 

defined i.e. symmetric and without splits, are noted down. Usually there are 3-

5 good peaks when the bolt is under stress. When the bolt is unstressed the 

resonant peaks are clearly spaced and well defined. Distortion in the spectrum 

is very less when the bolt is unstressed. 
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After a first sweep, a smaller sweep is done in 10 KHz bandwidths, in 

order to make sure that the peaks selected in the 1st sweep are good enough. If 

for e.g. the noted peak frequencies were 36.750 KHz, 45.250 KHz and 98.950 

KHz, the smaller sweeps are done over 30-40 KHz, 40-50 KHz, 90-100 KHz. 

The peaks are examined in each 10KHz sweep. If any additional peaks 

that seem to be good peaks appear in the 10KHz sweep, those frequencies are 

also noted down. 

3.1 Level of confidence in peaks 

The bolt load is now increased to say equivalent of 200 KN. The 

frequencies of the peaks noted previously are checked for shifts. The shifts are 

mostly +ve. There may rarely be -ve shifts with some peaks. The magnitudes 

of shifts are noted. Bigger the shift, more the confidence in a peak. Usually 

shifts are in the range of 20Hz to 200Hz for a 360 mm bolt length. Also any 

splits or distortions in the selected peaks are also noted down. 

The bolt load is increased to 220, 240 KN. The peaks are analysed in 

those loads and shifts are noted down. Finally the resonant peaks are picked 

according to their shifts, symmetry and repeatability across different bolt 

loads. 

By performing the above experiments, useful resonances are identified 

using Handyscope. However, resonances picked up by Handyscope have a 

resolution of 10 Hz - 25 Hz. Handyscope is used for preliminary identification 

of peaks from the spectrum using FFf analysis. A 1 or 10 Hz resolution is 

required to have a clearly defined highly accurate resonant peak. RI software 

is used to achieve 1 Hz resolution and accurate measurement of peaks using C 

and Matlab program. 

SECTION 4 - Building a calibration data set for a group of 10 bolts 

Having done the initial calibration of a single bolt, a calibration data 

set is built by testing a group of 10 bolts. A shift in resonant frequency is due 

to factors such as change in bolt load, bolt length, bolt extension position, 
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temperature and the actual testing structure. To build a calibration data set, the 

temperature is assumed to vary from 17 degree Celsius to 21 degree Celsius. 

The lengths of bolts in the group are same (± 0.5 mm). Bolt extension position 

is made the same for all the tests. The only variable is bolt load. For each bolt, 

resonances at 180, 200, 220 and 240 KN are noted down. Due to load loss, the 

loads in KN vary between 160 KN to 250 KN. An example of calibration data 

set is shown below. 

Length (mm) Load KN Fl (Hz) F2 (Hz) F3 (Hz) 

359.10 163.00 32627 44253 98521 

359.04 163.01 32756 44289 98517 

360.54 166.66 32668 44094 98320 

359.16 169.96 32733 44246 98633 

359.14 174.52 32808 44316 98658 

359.22 175.40 32839 44197 98596 

359.10 178.95 32684 44356 98613 

359.04 179.77 32778 44226 98564 

360.54 183.40 32687 44185 98365 

359.04 184.64 32781 44423 98716 

359.18 187.05 32687 44306 98584 

359.04 187.95 32803 44123 98571 

359.16 191.00 32778 44448 98660 

359.22 192.38 32875 44280 98736 

Table 1 

To build a calibration data set like the one above, a measurement of 

length of the bolt, load measurement using the load cell and measuring 

resonant frequencies using the resonant inspection instrument are required. 

Length of bolts can be measured using micrometer or other accurate devices. 

Resonances are calculated by the Matlab software, referred to as 

'HPDataAnalysis'. Note that the three resonances in the calibration data set 

were initially identified by using HS3 software at 24Hz accuracy. The aim is 

to measure those resonances to 1 Hz accuracy using DS335 as signal generator 
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and HS3 as data logger. Both controlled by software referred to as 

'HPResonantlnspection', that is compiled using MS Visual Studio and runs in a 

MS-DOS console window within Windows OS. 

The test rig and the instruments are set up as described before and the 

length of the bolt is measured before it is loaded to a suitable value. The HS3 

is used to identify useful resonances by testing the bolt at few different loads. 

The input transducer which was connected to the HS3 output for initial tests is 

now connected to the DS335 output, as shown in Figure 2 - the position of the 

switch b, indicates that the DS335 is now used as a sweep generator. 

CHI Out 

Out 

Preamplifi.er 

FIGURE4.2 

DS335 

Out 

USB Cable 

Power Cable 

PS/2 USB USB 

Computer 

( Test Rig Diagram J 

GPIB-USB 
Cable 

For the batch of bolts, the 3 identified resonances are present for all the bolts. 

A sweep bandwidth for a 100 Hz sweep is to be determined. Looking at the 

calibration data set, 3 suitable bandwidths are 31 kHz - 34 kHz, 43 kHz - 46 

kHz and 97 kHz - 99.9 kHz. To start without a calibration data set, 1 kHz 

either side of the useful resonances can be set as the sweep bandwidth for a 

sweep in 100 Hz steps. 
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4.1 Software Setup 

The aim is to setup the instrument software and sweep over the 

identified bandwidths to get accurate resonance information. Once the 

instrument are setup, all the program files are provided in the zip file named 

'SoftwareCode.zip', located in C:\SoftwareCode.zip. Extract the contents to a 

folder C:\Software Code. 

Click on Microsoft VC++ 6.0 icon on the desktop or Click Start-> All 

Programs-> MS Visual C++ 6.0 ->MS Visual C++ 6.0. Click File-> New. 

Click on the projects tab, select Win32 Console Application. Set the location to 

C:\ and in the project name box on the right, enter HP Resonantlnspection. 

Click OK. In the new dialog box, select An empty project. Click Finish. Click 

OK. Now a folder called HP Resonantlnspection will appear on the C:\ drive. 

Copy all the contents of the folder C:\Software Code to the C:\HP 

Resonantlnspection folder. 

Browse to C:\HPResonantlnspection\hpresonantinspection.cpp. Then and click 

OK. Now the file is displayed in the editor. 

Then select View -> Workspace. On the bottom of the workspace, 

choose File View. Workspace is displayed on the left side of the editor. Click 

Project -> Add to Project -> Files. Browse to 

C:\HPResonantlnspection\hpresonantinspection.cpp. Click OK. Now the file 

is displayed in the editor. Click Project -> Add to Project -> Files. Browse to 

the project folder i.e. HP Resonantlnspection folder on the C:\. Select 'All 

files' in the 'Files of type' section. Now 'gpib-32.obj' is displayed. Select that 

file and click OK. The file gpib-32.obj is added to the project files, in the 

project workspace. 

1. Press Ctrl+F7 to compile the file. 

2. Goto C:\HP Resonantlnspection. Copy the files hs3f12.hex and gpib-32.obj to 

C: \HPResonantlnspection \Debug 

3. Press Ctrl+F7 again to compile 

4. Press F7 to link 

5. Press F5 to run the program. 
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All the files have been setup and the program can be started. This. setup 

has to be done only once. For further use, the workspace can be opened 

directly by clicking File -> Open Workspace -> 
C:\HPResonantlnspection\hpresonantinspection.dsw . To run the program, 

click on the file 'hpresonantinspection.cpp' in the workspace. It is displayed on 

the editor. If it doesn't appear, choose File View below the workspace or setup 

the project again. 

4.2 Running the program 

1. Press Ctrl+F7 to compile. 2 Press F7 to link 3. Press F5 to run. 

2. A console window opens and shows HS3 Initiliased. 

3. Enter sensitivity in Volts. Sensitivity is matched to input signal. 

4. Then DS335 initialized 

5. Enter step of frequency sweep. (1,10,100)Hz. 

For a broad sweep use 100Hz For e.g. if the band 31-34kHz has a 

resonance (known by using HS3 previously), at 32000. The very first sweep step 

would be 100 Hz. The sweep bandwidth can be reduced by identifying the refined 

start and stop frequencies using MATLAB. For e.g. the MATLAB software would 

identify the resonance at 32000 to 100 Hz accuracy. Which means the matlab 

software can identify the first resonance to be anywhere between 31900 and 32100. 

6. Enter datafilename. Format filename.dat. For subsequent sweeps, enter 

different filenames becoz all filenames should be unique. E.g. filenames can 

be data0l.dat, data02.dat etc 

7. Select Sweep mode. 

8. Enter the number of bands over which sweep will be carried out. From the 

calibration dataset example, a sweep over three bands 31 kHz - 34 kHz, 43 

kHz- 46kHz and 97kHz- 99.9 kHz is required. So enter number of bands as 

'3 ', in this case. 

9. If sweep mode = 2, the format for entering the start and stop frequency in Hz 

is FREQ0000000. For e.g. for 38kHz= 38000 Hz. Enter FREQ0038000. For 

102kHz= 102000 Hz, enter FREQ0102000. 

10. If sweep mode 1 was selected, the program retrieves start and stop frequencies 

from a file created by MATLAB. 
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At the end of sweeps, the program exits by itself or just press any key for the 

console window to close. 

4.3 Data Analysis - Extracting Resonant peaks 

Further analysis is done on MATLAB. Click MATLAB 7.0.1 icon on 

the desktop to open the MATLAB software. It can also be opened by Start-> 

All Programs-> MATLAB 7.0.1-> MATLAB 7.0.1 

On the MATLAB toolbar, set the current directory to 

C:\HPResonantlnspection. Click File -> Open. Select HPDataAnalysis.m, 

click OK. Again Click File -> Open. Select HPRefineSearch.m, click OK. 

Now there are two editors open in MATLAB, for the above two files. 

HPDataAnalysis is used for plotting, selecting resonances. 

The main function of HPDataAnalysis software is to plot the frequency 

response of the bolt. The plot of the response is interactive. The x values in the 

plot denote frequency values and y values in the plot denote rms voltage. 

Having run the HPResonantlnspection software to sweep over the 

required frequency bands, HPDataAnalysis is to be run next. 

4.4 MA TLAB program procedure: 

1. Activate HPDataAnalysis window 

2. Press F5 to run the program 

3. The program processes the data acquired by the HPResonantinspection 

program and plots the resonance spectrum. Each band has a separate plot 

and there is a full plot comprising all the bands. 

4. 1 Hz is the maximum accuracy that can be obtained. So if the sweep was 

done for 1 Hz, no further action is required in the program. 

5. Click the main MATLAB window. The resonances are computed in the 

main MATLAB window is noted down. 

6. If the sweep step was 100Hz, the figure windows are activated. Figure (1) 

displays the resonance in first sweep band; figure (2) displays the 

resonance in second sweep band and so on. 
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7. Click the first figure window. Using the mouse, select start and stop 

frequencies on the either side of the peak. Note that the peak displayed has 

an accuracy of 100 Hz. A narrow sweep is required to identify it to 1 Hz 

resolution. So the values to be selected either side of the peak will be the 

new start and stop frequencies over which the next weep will be done. 

For e.g. to identify a resonance between 32000 Hz- 34000 Hz, 

sweeping at 1 Hz resolution takes lot of time, because it is 2000 frequency 

steps. So a 100 Hz step sweep is done, which is 20 frequency steps over the 

2000 Hz bandwidth. After that using the MATLAB figure window the peak is 

identified to be at 32500 Hz. So if we select the new start and stop frequency 

to be 32400 and 32600 respectively, a 1 Hz sweep takes only 200 steps. So we 

have effectively reduced the steps from 2000 to 200. 

In the figure window, select a value on the left side of the 

highest point of peak and Click Store. Then select a value on the right side of 

the highest point of peak and Click Store. Now the new start and stop 

frequencies of band 1 are stored. Do the same for all the other figure windows. 

At the end, there are new start and stop frequency values stored for each 

frequency band. Close all the figure windows. 

8. Click the HPRefineSearch window. Press F5. 

9. Return to the MS Visual Studio. Run the file HPResonantlnspection as 

previously described in 4.2. Enter a new step size (1 Hz or 10 Hz) and 

enter a new file name. Select Mode 1. The software sweeps over the bands 

that were selected by the user in the MATLAB figure window. 

'to. At the end of the sweep, come back to MATLAB. Run the program 

HPDataAnalysis. Now the figure windows show resonances to 1 or 10Hz 

accuracy. Note down the values of the resonance from MATLAB. 
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SECTION 5 · LOAD PREDICITON 

Once a calibration data set is built like the one in figure 4.1, load can 

be predicted for any of the bolts in the group of say 10 bolts, using the Matlab 

program loadprediction.m Open the file using the same procedure as described 

before. It is located in C:\HPResonantlnspection\loadprediction.m. 

Before running load prediction, find out resonances of the bolt for 

which the load is to be calculated. The resonances to be found are similar to 

the ones in the calibration data set. In this particular example, the resonances 

for a bolt in the group would be in 32 kHz - 33 kHz, 44 kHz - 45 kHz and 98 

kHz-99kHz. 

Resonances are measured for the bolt under test. The resonances and bolt 

length are inputs to the multiple regression algorithm loadprediction.m and the 

output is a predicted load. 

In the file loadprediction.m, the variable F takes in a vector value. The format 

for entering the resonances and bolt length to vector F is F = [Fl F2 F3 

Length]. Fl,F2, F3 are in Hz and Length in mm. In practise, it would be for 

e.g. F = [32875 44280 98736 359.22], where the values have been obtained by 

measuring the appropriate resonances and length of the bolt under test. 

Press F5 to run the program. The program predicts the load in KN. 
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